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Welcome to Activstudio 3
We've been listening to what teachers want and have distilled that
feedback into the latest version of Activstudio. In this booklet we will
introduce you to some of the most important new features of the
software.

In brief

We’'ve enhanced the software, so Activstudio is even better for
teaching at an interactive whiteboard.

We've made designing lessons simpler, whilst significantly
increasing the opportunties for creativity.

We've improved the training we offer you.

...all working together to help improve your students’ learning.
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THE DASHBOARD:

THE LAUNCHPAD FOR YOUR TEACHING

Activstudio 3 comes equipped with a whole new launchpad for your

teaching: the dashboard. The dashboard helps you to organise your
teaching and offers the starting point where you can really learn how
to make the most of Activstudio and your interactive whiteboard.

Configure

Training

Create:

Open from:

g Hew Flipchart
g Custom Flipchart
Flipchart Builder
@ Assessment/Quiz
@ Activity

Open a recent flipchart:

E, Shared Flipcharts
é 7 My Flipcharts

E Shared Assessments
m My Assessments

y J Other Location

Tools and Wilities:

'}1 E Activiesouree Manager

% Activmarker for MS Office (Off)

- Powerpoint Converter

C/ Export Wizard
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The Dashboard

Training
Visit this page to find the training method of your choice.
Choose from:

Online courses
Manuals
Face-to-face training

PROMETHEAN

Online Training & Accreditation

DESICNED BY TEACHERS

TRAINING.

FOR TEACHERS.

Training Manuals

Some of the dashboard’s most important sections:

Face to Face Training

Online training courses which lead to
recognised accreditation are now available
at prometheanlearning.com

S FREE Professional User
3 courses
Sign up now.

Courses feature fully
interactive tutorials and tracked
assessments.

Curriculum Developer
courses

Eight week courses
mentored by an WWB expert
focuses on how to use your Activ
software in the classroom.

Available soon
Wersion 3 software courses
Training & Resource Developer courses

Training manuals are available to download
from here. These are PDFs requiring
Adobe Acrobat Reader

Introducing Activstudio
This manual shows you how to get started
with Activstudio

Introducing Activprimary
Thiz manual shows you how to get started
with Activprimary.

Full training manuals and further skills
manualg are available when you sign up
for our online courses.

Version 3 software
Manuale to suppert version 3 new
features are available:

Aclivsiudio New Features manual
Activprimary New Features manual

@Promethean Lic 2007

At Promethean, we provide face to face
training solutions to suit your needs.

Onsite training
sessions

Training can be delivered at
your school or institution

Find out more about the courses
available >>
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The Dashboard

Promethean Planet

Register for free on Promethean Planet to join the Promethean
community and share resources, flipcharts and ideas with other
teachers

Suppott

PROMETHEAN PLANET

If you use an inter: re whiteboard or electronic voting system, Promethean Planet is for you.
It's a FREE, online community designed with one goal - supporting teachers. Learn more =

USEFUL LINKS FEATURED RESOURCES

The Digital Chalkface
A global collection of stories, reports and papers There are countless ways to get the most out of your
reflecting good practice and research using lessons and numerous technigues as a means of
Interactive Whiteboard and associated peripherals demonstrating concepts.

in the classroom.

Example Pages

Who wants to be a Gazillionaire?

Planet News Here's a briliant blank fipchart template for “Whe wants
Features information about special people, places to be a milionaire?". Add your own text and akternative
and opportunities. With thousands of aNsWers

Activclassroom teachers throughout the country,
" there's bound to be plenty to share.

Blockbusters Template
This single page flipchart template enables you to set up
a two team game of Blockbusters.

\ Tips from the Pros
A little extra help goes a long way. Our TLAS are
ready and waiting to provide the assistance you

need to make your Activelassroom more efficient > More featured resources
and effective. = Search resources
Forum

The user forum is designed to serve as a gathering
place for Activclassroom users to share
experiences, learn from colleagues.

E]l

0
@Promethean Ltd 2007 x
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The Dashboard

Support
Check here for software updates.

Configure onling Training

Program Details: Device Driver and Hardware Details:

Activstudie} v3.0.50 Criver version: 4.1.8.128

Check For Update

Support Website

Support Tools

é) Get System Details

0
@Promethean Ltd 2007 k
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LESSON CREATION IS QUICKER

Teachers have asked us to create templates to help with lesson
design. These templates are now instantly available by clicking on
Flipchart Builder in the dashboard.

Flipchart builder and flipchart templates

More flipchart templates will be available to download from
www.prometheanplanet.com.

B@E A E 2] N@‘
- I = == A e

Save and Show in
Sctivstucio

ap

blank writing frame with image (fight) and head =
[5Y blank wriing frame with image (right].ap2
-3 it

| EOOmm
(JEECEEE
(HHE MO
=

EB Fipchart Buider

TS

2] Wekome to Activtud... | 2 Actvstudo
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DESIGNING FLIPCHARTS IS SIMPLER

We have created Design Mode and Presentation Mode. Use Design
Mode to create flipcharts. Use Presentation Mode’s teaching layout
when working at an interactive whiteboard, keeping the most
important tools within easy reach.

Design Mode and Presentation Mode

R
| X BT ST T T3 T 6000n /s /Em-ra0
1= il =
Design Made s
Flipchart %P
Ackivote ¥
Cuskamise. ., 4
Studio Settings...
Ackivexkras 4
Help ' Design Mode
flipchart examples
E:xit

nafEYe s

Presentation Mode
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IMPORT AND EXPORT RESOURCES

Tools and Utilities:

k @ Activresource Manager

@ Activmarker for M5 Office (Off)

Powerpoint Converter

O

Tl Export Wizard
A

Visit the Activresource Manager for
options which let you import and
export resources.

Download themed Pack and Go
resources from Promethean Planet.

Pack a set of resources you have created so they can be shared
easily with colleagues.

Shared Collections k
Basic resources
- History
= Tudors Q
EBuildings
- Characters FFFNI’P“
County Elizabeth
Figures
Furniture
Maps
Music
| M Ferry i Hm W m Seymor by s Wary Tugor i
Punishment
Religion & .' X
Fopal
Ships Raleigh Shak ol
i e clespeare  lsey
Warious
< Weapons
ICT
Music
. Physical education
Shared Flipchart Pages
Total files: 15 File size: 261 kb
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FOCUS ON TEACHING

Exclusive to Activstudio and Activprimary software: now you just
have to wave your Activpen to make what you want happen.

Gesture technology

You can turn the page, switch on your favourite tool or even save
your document without having to click on any icons. In this way you

can simplify the software so that it does exactly what you want.

Activite Gesture YWheel
Clock [ Enable Gestures Test:
Dazhboard
Deszign MUP‘E [V Show Gesture Points
Desktop Flipchart
Effects .
Flipchart Tolerance:
Flipchart Ohjects h
General Strict Relaxed X
Gesture Wheel ) ,;81‘_0 '23
Language Size: -
Linked File Hosting - 3
hultiple Monitors Smaller Larger
online Resources
Profile and Resources Speed:
Recordings Ji
Right Buitan
Shape Recognition et S
Taolkaxes Gesture: [10 Pen Tool Ondoif [A]
Toolz 20
Uszer Input 30 Mext Page
40
=) Colour Selector [V]
Action: |Unused [A]
Main Toolko:x
Guick Select Toolz
First Page [v]
QK | cancel |
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INTERACTIVE FLASH RESOURCES

Visit the Shared Activities section of the Resource Library for some

interactive Flash resources to help when working with numbers and
words.

R
SRR
B

| s

CICE==)]
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COOL NEW FEATURES FOR DEVELOPERS

Advanced users of Activstudio have been clamouring for yet more
features to give them further creativity when creating lessons. The
new options in the Properties and Actions box offer over 200 new
actions and other settings for you to explore!

The Properties and Actions box

To find the Properties |[————— -
. Ifentification Paosition

and Actions box Ecstnd Left [557

) ppearance Top[015
double-click on an Cortarer g
item on your page and [ A
select the Properties sz
icon from the Object Micze
Edit toolbox. o | resasz= |
Idertification Actions
Posi
A?a?a:a:ance L £ Page
Containet *  Filz (" Ohject
Restrictors
Actions " Activstudio function " Object size

" Object postion
[ Prevent the action when ohigct is hidden

|Play Sound ﬂ
Set File cheer kids.wav

Idertification Container
Position [ Return if not contained
Appearance
Container I Reward sound
Restrictars
Acti
1ons Can cortain: |Any’thing ﬂ
Contain rule: |Enclose Ohbject ﬂ

Identification Cantainer
Postion [ Return if not contained

Appearance
Container [ Reward sound
Restrictars

Actions - N
oK Can contain: |Mothing j
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EXTRA TOOLS IN THE TOOL STORE

Previously, some of Activstudio’s most popular icons, such as the
Straight Line tool and the My Images icon, were not available in the
Tool Store. Now you can add these icons, and many others, to any
toolbox of your choice.

Explore the Tool Store.

To customize your 'Presentation Mode' Toolboxes and Toolbars you may perform any of the !ﬂ E‘ L
fallowving 3 actions:

17 &dd tools: _ 8 Qn _é

Drag toaolz from the Tool Store and drop them into any Toalbax or Toaolkbar.

ﬁﬁﬁ

"///?T%fQGBWﬁﬁ e
Presentation Tools . _ : m /
V& 4

T

OEAeDPBOSNE S A= O =
Rl LAY L e P
ﬂﬁ?bro—>au/| )
n+x«.ui + - Eled =R

Tl NN iRy =T

@ﬂ‘@eﬁu

(o]
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INSERTING LINKS IS EASIER

Using multimedia such as Flash files and videos is a fundamental
part of Activstudio. Now, inserting links to a range of file types is
easier. Explore the options here, also, to place the videos and Flash
files directly in the flipcharts.

Paste 3
Insert 3 Flipchart Link. ..
Web Site Link... %
Export Page. .. Office File Link. ..
v Enable Actions Flash File Link. ..
Show Action Objects Yideo File Link. ..

Sound File Link...
Other File Link...

Flash Placeholder...
Wideo Placeholder ...

Mew Page Before Current Page
Mew Page After Current Page
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WORKING WITH TEXTS

HAS

K

BEEN STREAMLINED

Instant typing
Now to type on the flipchart just click where you want to put the text
and start typing.

Text editing

To edit text:

Click once on the text to select it.

Click on the text again to begin editing.

Text format painter

If you like the look of a text on the page you can now copy the text’s
formating to other texts.

To do this:

Select the Colour Picker tool.

Press Ctrl on your keyboard and, at the same time, click on the text
to copy its formatting.

Select the Fill tool.

Press Ctrl on your keyboard and, at the same time, click on any text
you want to change to the copied style.

Instant colour change
Select a text and now you can change its colour using the Main
toolbox’s colour pallete.

Reflect your texts &
Right-click options D R
now let you reflect m:mvl- 1
Edit » Zuk
your texts. Pacte M Copy
Insett 3 Copy to Clipboard
Duplicate
Export Page. .. Delete
v Enable Actions Fit 4
Show Action Objects Mirror 3 In % Axis
fake Tickertape Flip 3 In ¥ Axis %
Dreconstruct Lok
Unlack,
To Front
Tao Back
Laver 4
Align 4
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MORE OPTIONS
WHEN WORKING WITH IMAGES

Pick-up boxes

A small but important demonstration of how we respond to teachers’
feedback. We've moved two of the software’s pick-up boxes so that
they are easier to select on an interactive whiteboard.

ORI @ S c s
ACTIVSTUDIO™

o
|
0 [ g

You can change the size of the pick-up boxes in the Flipchart
Objects section of the Activprimary Settings box.

gACTIVSTU DIOL

Pick-up boxes are now also available on Flash objects.

Instant grouping B
We've created an icon to make
grouping easier. Select two or more
objects and the grouping icon will
appear with the other pick-up boxes.
Click on this icon and your items
will be grouped. Click on it again to
ungroup your icons.

X

om
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More options when working with images

Marquees
When an item is selected it is surrounded by a
rectangle.
- - - =
Edit » Cut
Allgnllng images _ . ' B B o
Creating neat pages is easier with Insert » Copytociphoard
. . L Duplicate
the help of these new right-click Export Page. . Dekte
. . . w Enable Actions Fit »
options. Using these options, you how dcton Obiects | Vs v
can select a number of options ok ’
and line them up instantly e
0 Back
o .
Align » Left
= Cen%x
Right
Top
Centre ¥
Bottam
Width
Height
angle
Complete
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REFINED TOOLS

Flipchart Bin
Just click on an item then click on the Flipchart
Bin to delete the item from the page.

Show/Hide Resource Tree &"
We've placed this icon lower down on the

Resource Library so it is easier to click whilst

at an interactive whiteboard.

Camera tool

Now you perform keyboard nudges when using
the Camera tool. Click on the arrows on your
keyboard to help you define the area you want
to snapshot.
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NEW ICONS

Feedback from teachers has told us that icons at the top of the
board are sometimes too high for them to reach.

Until now, four important icons were located up here. Now they’ve

been set free and given a new look. You can find them in the Tool
Store so you can add them to any toolbox of your choice:

zl Page Notes
Page Scale

:.'_._':I Arrange Windows

g Enable Actions

Chject Edit

Object Edit toolbox — new icons p— =
‘ - N T

A transparency slider has been

added to the Object Edit toolbox, &

letting you make your images more or less translucent. Two new
buttons let you arrange your images, sending them to the back or
front of a group of images. Double-click on any item on your page to
open the Object Edit toolbox.

Fraction Creator tools
Options are now available so your fractions can be made up of
numbers and/or letters.
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CUSTOMISE THE SOFTWARE

The ability to customise Activstudio has always been one of its
greatest strengths. Teachers now have even more options to set up
the software exactly as they want it. Use a Windows-style version of
the software or the teacher-focussed Activstudio style.

IF'

v Design Mode
Flipchart

Customise. ..
Studio Settings. ..
Activextras

Show Dashboard
Help

Exit

b Tool Store...
Profile

b Size
Orientation
Colours

Flipchart Style
w Menu Bar

AEHOSN
EOQe%

v Main Tool Bar
v Side Bar
w Status Bar

v Allow Design Mode
v Allow Desktop Annotation
w Show Shorteut Bar

v v o o

| Standard Activstudio |
v Standard Windows %

b BB

AT P e [T ... [Ty Lo, ETTTT

Standard Activstudio

Standard Windows

=

v Design Made
Flipchart

Customise. .,
Studio Settings...
Activextras

Show Dashboard
Help

L3

Now you have the option to choose
which toolboxes you want to see.

b Tool Store... [}\
Profile 4
3 Size 4

Crientation
Colours

Flipchart Style
v Menu Bar
v Main Tool Bar
 Side Bar
v Status Bar

v Allow Design Mode
v allow Deskkop Annotation
w Show Shortcut Bar

© 2007 Promethean Ltd

TP-1678-UK Activstudio 3 New Features 19



PROFILES

If you want to see more tools — or less tools! - as you teach, try
experimenting with the profiles in the dashboard. Start with the
basic profile and as you become more confident with the software,
change your profile here. You can also create your own profiles, so
the tools you see are tailored to your lessons. These profiles can be
saved to use again, or shared with colleagues.

Training

Setup Activboard:

Customise Your Profile:

D Configure (Board is connected)

% Calibrate Board

Setup Activote:

E:E' Toolstore

"o
General Program Settings
-—

Load/Save Profile:

% Register Devices
L Register Users
S

B85 Manage User Groups

'J ;b AssessmentQuiz Wizard

Setup Activslate:

Select from installed Profiles

Foundation

Advanced
Corporate

IMEErMEdiEte ]

Promethean hardware attached

Register Devices

Virtual Voting - (Requires Activote VR)

The following funetions are enabled:

Handwriting Recognition
Gesture Actions

ﬁg Server Unavailable

Activote
Activslate

@Promethean Lid 2007
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?X

The Grid Designer ]
The Grid Designer, available in the Tool = wsib.? o = %

Store, lets you design the exact type of | B
. Defaul scale: 1 scale step
grid you want. .
Thumbnail scale: 1 05 B
Grid Level:

Current Level |1 = jj
To Front

v isihle v Snap
Xetatfl | vstetp
H step: ’327 VW step: ’327
Colour, .
e
Type: ’m
Direction: ’h‘

The Activcataloguer

The Activcataloguer is for anyone who wants to
create a set of thumbnails of their flipcharts.

Select a folder to catalogue:

,”3.\Ducumanls and Settings'sgreenily DocumentsiActivstudio3 iy Browse...
Flipchartsh

[~ Catalogue subfolders

Choose an output flipchart name and folder:

(CDocuments and Settingsiegreenivly Document s\ Activstucio 3ty Browwse
Flipchartshcatalogue flp

Search for files of type: W Flipcharts snd Pages | Resources

Select athumbnail size: ™ 160 *120 + 80 *60

|Ready

© 2007 Promethean Ltd TP-1678-UK Activstudio 3 New Features 21



Other Features

Publish flipcharts

The Publish feature limits other people’s ability
to copy your work.

Flipchart

»

v Design Mode

Custarmise.
Studic Settings.
Activextras

»

»

Show Dashboard
Help

»

New b
Open From »
Save To »
Prirt...

SUMMArY..

Exit

Update Thumbnails

HOQes

8 L,EHO=SN

Embed File Actions
Tmport

Export »
Publish... [

Flipchart: Publizh

Publizher Information:

Restrictions:
v Prevent Copying Pages and Objects
v Prevent Flipchart Saving and Exporting
v Prevent Flipchart Printing

v Prevent Cameta Tool

Save Details Fublizh...

Cancel

22

TP-1678-UK Activstudio 3 New Features

© 2007 Promethean Ltd



Access more ideas on training via the dashboard or alternatively log
on to www.prometheanlearning.com

You can also access Promethean Planet via the dashboard or
alternatively log on to www.prometheanplanet.com. Visit this
website for news, tips, resources and user forums.

Monday - Friday 09.00 - 17.00 GMT
+44 (0) 870 241 3194
support@prometheanworld.com
www.prometheanworld.com
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BOARD SOFTWARE SLATE VOTE

Monday - Friday 09.00 - 17.00 GMT
+44 (0) 870 241 3194
support@prometheanworld.com
www.prometheanworld.com

Promethean House, Lower Philips Road, Blackburn, Lancashire BB1 5TH UK



